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Virtual appliance installation overview
Learn how to install ViPR SRM as an appliance in a supported VMware environment.
This guide describes the deployment process using the vSphere vCenter Client. The
ViPR SRM vApp can also be installed using the vSphere Web-based Client, but the
details are different and not included in this guide.
Any new vApp (4VM or 1VM) installations require vSphere vCenter Client 5.x or 6.0.
This includes adding a vApp 1VM to an existing installation.
When you deploy the ViPR SRM vApp on a cluster of ESX servers, the vCenter DRS
function (Cluster features) must be enabled. If it is not enabled in your vCenter
environment, set DRS to on and set the vCenter DRS Automation level to Manual.
After you complete the ViPR SRM deployment, you can disable the DRS function.
The vApp is based on SuSE Enterprise Linux 11 SP3.
The MySQL version included with the product is 5.5.48 MySQL Community Server
(GPL).
Do not add any binary VMs into the vApp container (including any ViPR SRM binary
VMs).
The procedures enable you to install two types of software:
Core software
A reporting solution built on a scalable architecture of backends, frontends, and
distributed collectors. When you install the core software, you establish the
foundation for the product, which provides common capabilities, functions, and
user interfaces. In addition, the following separate software products are preinstalled with ViPR SRM: ViPR SRM 4.0.2 SOFTWARE IMAGE (453-010-807)
and SLES 11 SP3 SW GPL3 OPEN SOURCE SOFTWARE (453-010-808).
SolutionPacks
Software components that support EMC and third-party storage infrastructure
components. Each SolutionPack enables you to select a specific report in the UI.
To learn more about the SolutionPacks that ViPR SRM supports, see the
following documents:
l

EMC ViPR SRM Support Matrix

l

EMC ViPR SRM Release Notes

l

EMC ViPR SRM SolutionPack Guide

ViPR SRM vApps are distributed using Open Virtualization Format (OVF) files.
Depending on your environment's requirements, you will use the 4VM vApp OVF or the
1VM vApp OVF files.
4VM vApp OVF
Enables you to install four VMs (Frontend, Primary Backend, Additional Backend
and one Collector). A vApp VM will include an ADG directory that is used by the
autoconfiguration process of the vApp VMs.
1VM vApp OVF
Enables you to install a single vApp VM. The options are Frontend, Primary
Backend, Additional Backend, Collector and All-in-One. You can use this option to
install additional Collectors and Additional Backend VMs to scale out the existing
ViPR SRM installation. You can add a single vApp VM (Collector or Additional
Backend) to an existing vApp container that was created with the 4VM vApp.
8
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When you restart the vApp container, the new VMs will be autoconfigured into
ViPR SRM. vApp VMs include an ADG directory that is used by the
autoconfiguration process. You can also use the 1VM vApp for small All-In-One
proof of concept solutions.
ViPR SRM vApp VMs have properties that are used to configure the host level
networking information. If the vApp VM/folder needs to be moved from one vCenter
to another, you must use the vCenter export and import procedure. Do not use the
vCenter remove from inventory method. For additional details, refer to Guidelines for
Managing VMware vApp Solutions (h15461).
ViPR SRM vApps fully support the VM vMotion and Storage vMotion DRS functions
of vCenter.

Installing the 4VM vApp
You can deploy the ViPR SRM 4VM appliance from an OVF template using a vCenter
Client. The installer creates the vApp container and deploys 4 vApp VMs (Frontend,
Primary Backend, Additional Backend, and one Collector) inside the vApp container.
Before you begin
l

If you are installing ViPR SRM on a cluster of ESX Servers, DRS must be enabled.

l

Gather the following information:
n

vCenter location where you plan to deploy the appliance

n

A single DataStore is needed for deployment. After completing the deployment,
you can use Storage vMotion to move the VM's storage to different
DataStores. The final storage size per VM will be provided by EMC.

n

Static IP address for each VM. This IP address must be registered in DNS with
forward and reverse lookup before you begin the deployment.

n

Gateway

n

Netmask

n

DNS servers

n

Domain search strings. For a distributed ViPR SRM environment, the domains
for all the ViPR SRM servers must be entered for each of the ViPR SRM
servers.

Procedure
1. Navigate to the Support by Product page for ViPR SRM (https://
support.emc.com/products/34247_ViPR-SRM).
2. Click Downloads.
3. Download the ViPR SRM <version number> vApp Deployment zip file.
Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility.
The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 4VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.
4. Open vCenter Client and connect to the vCenter Server that manages your
VMware environment.
Do not run vCenter Client on a VPN connection.
Installing the 4VM vApp
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For the fastest deployment time, the host running vCenter Client should be
local to the ESX servers.
5. Select where in the vCenter ESX cluster/server you want to deploy the VMs for
ViPR SRM.
6. Select File > Deploy OVF Template.
7. In the Source step, locate the 4VM OVF template file.
8. Click Next.
9. In the OVF Template Details step, review the details of the loaded OVF file,
and then click Next.
10. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.
11. In the Name and Location step:
a. Specify a new name or accept the default name for the appliance.
b. Specify an inventory location for the appliance in your VMware environment.
c. Click Next.
12. In the Resource Pool step, select the Resource Pool or the folder where the
deployment will place the ViPR SRM VMs, and click Next.
13. In the Storage step, select the destination storage (DataStore) for the virtual
machine files, and then click Next.
The compatibility window will state if there is insufficient disk space on the
selected DataStore, and a warning will display when you click Next.
14. In the Disk Format step, select the storage space provisioning method, and
then click Next.
Option

Description

Thin-provisioned format On-demand expansion of available storage, used for
newer data store file systems.
Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

Note

ViPR SRM is fully supported on thin-provisioned storage at the array or
virtualization level. Thin on thin is acceptable, but not recommended.
15. In the Network Mapping step, select a destination network for each of the
VMs, and then click Next.
16. In the IP Address Allocation step, choose the IP allocation policy and IP
protocol to use, and then click Next.
17. In the Properties step, provide the values for each of the VMs, and then click
Next.
18. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.
A pop-up window opens in vCenter Client showing the deployment progress.

10
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19. After the 4VM deployment finishes, in the Deployment Completed
Successfully dialog box, click Close.
20. Use the 1VM OVF to add any Additional Backend VMs and Collector VMs as
described in the following section.

Install additional ViPR SRM vApp VMs overview
You can scale ViPR SRM larger by adding additional databases (Additional Backends)
and Collectors. Use this procedure to deploy Additional Backend and Collector VMs
needed to scale the ViPR SRM environment. This will be accomplished by adding
Additional Backends and Collectors VMs to the existing ViPR SRM vApp container and
by deploying Collectors vApp VMs in different data centers.
Use this section for adding Additional Backends, Collectors, and Slave Frontends, or
for POC and lab installs of the ViPR SRM All-In-One solution. (The All-In-One solution
is not supported for managing production environments because it will not scale.)
Any new vApp (4VM or 1VM) installations require vSphere vCenter Client 5.x or 6.0.
This includes adding a vApp 1VM to an existing installation.
When you deploy the ViPR SRM vApp on a cluster of ESX servers, the vCenter DRS
function (Cluster features) must be enabled. If it is not enabled in your vCenter
environment, set DRS to on and set the vCenter DRS Automation level to Manual.
After you complete the ViPR SRM deployment, you can disable the DRS function.
The vApp is based on SuSE Enterprise Linux 11 SP3.
The MySQL version included with the product is 5.5.48 MySQL Community Server
(GPL).
Do not add any binary VMs into the vApp container (including any ViPR SRM binary
VMs).
The procedures enable you to install two types of software:
SolutionPacks
Software components that support EMC and third-party storage infrastructure
components. Each SolutionPack enables you to select a specific report in the UI.
To learn more about the SolutionPacks that ViPR SRM supports, see the
following documents:
l

EMC ViPR SRM Support Matrix

l

EMC ViPR SRM Release Notes

l

EMC ViPR SRM SolutionPack Guide

ViPR SRM vApps are distributed using Open Virtualization Format (OVF) files. You will
use the 1VM vApp OVF files to scaleout Additional Backends, Collectors, and
Frontends.
1VM vApp OVF
Enables you to install a single vApp VM. The options are Frontend, Primary
Backend, Additional Backend, Collector and All-in-One. You can use this option to
install additional Collectors and Additional Backend VMs to scale out the existing
ViPR SRM installation. You can add a single vApp VM (Collector or Additional
Backend) to an existing vApp container that was created with the 4VM vApp.
When you restart the vApp container, the new VMs will be autoconfigured into
ViPR SRM. vApp VMs include an ADG directory that is used by the
autoconfiguration process.
Install additional ViPR SRM vApp VMs overview
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ViPR SRM vApp VMs have properties that are used to configure the host level
networking information. If the vApp VM/folder needs to be moved from one vCenter
to another, you must use the vCenter export and import procedure. Do not use the
vCenter remove from inventory method.
ViPR SRM vApps fully support the VM vMotion and Storage vMotion DRS functions
of vCenter.

Deploying Additional Backend and Collector VMs in an
existing Container
After completing the 4VM deployment, use this procedure if your design requires
additional Databases or Collectors in the same vCenter datacenter.
Before you begin
l

To deploy additional Collectors in different datacenters, refer to Deploying
Collector VMs in different datacenters.

l

If you are installing ViPR SRM on a cluster of ESX Servers, DRS must be enabled.

l

Gather the following information:
n

vCenter location where you plan to deploy the appliance

n

A DataStore is needed for deployment.

n

Static IP address for each VM. This IP address must be registered in DNS with
forward and reverse lookup before you begin the deployment.

n

Gateway

n

Netmask

n

DNS servers

n

Domain search strings. For a distributed ViPR SRM environment, the domains
for all the ViPR SRM servers must be entered for each of the ViPR
SRMservers.

For instructions to add remote Collectors, see Deploy Collector VMs in different
datacenters.
Procedure
1. Navigate to the Support by Product page for ViPR SRM (https://
support.emc.com/products/34247_ViPR-SRM).
2. Click Downloads.
3. Download the ViPR SRM <version number> vApp Deployment zip file.
Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility
The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 1VM OVF deployment file on the host
running the vCenter Client or place the files on the DataStore.
4. Open vCenter Client and connect to the vCenter Server that manages your
VMware environment.
Do not run vCenter Client over a VPN connection.
For the fastest deployment time, the host running vCenter Client should be
local to the ESX servers.
12
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5. From the list in the vCenter tree, select the location where you want to place
ViPR SRM.
6. Select File > Deploy OVF Template.
7. In the Source step, locate the 1VM OVF template file.
8. Click Next.
9. In the OVF Template Details step, review the details of the loaded OVF file,
and then click Next.
10. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.
11. In the Name and Location step:
a. Specify a new name or accept the default name for the appliance.
b. In the Inventory Location, select the Datacenter and sub-location where the
appliance will be deployed. Navigate through the folder levels to define the
exact location.
c. Click Next.
12. In the Deployment Configuration step, select the type of appliance VM that
you want to install.
13. In the Host/Cluster step, select the ESX server or ESX Cluster, and click Next.
14. In the Resource Pool step, there is a list of the vApps that are already installed.
Select the ViPR SRM vApp, and click Next.
15. In the Storage step, select the destination storage (DataStore) for the virtual
machine files, and then click Next.
16. In the Disk Format step, select the storage space provisioning method, and
then click Next.
Option

Description

Thin-provisioned format On-demand expansion of available storage, used for
newer data store file systems.
Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

Note

ViPR SRM is fully supported on thin-provisioned storage at the array or
virtualization level. Thin on thin is acceptable, but not recommended.
17. In the Network Mapping step, select a destination network for the VM, and
then click Next.
18. In the IP Address Allocation step, choose the Fixed IP allocation policy and IP
protocol to use, and then click Next.
19. In the Properties step, provide the values for each field, and then click Next.
20. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.
A pop-up menu that shows the deployment progress opens in vCenter Client.
21. After the 1VM deployment finishes, in the Deployment Completed
Successfully dialog box, click Close.
Deploying Additional Backend and Collector VMs in an existing Container
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22. Repeat this process for each Additional Backend and Collector needed in this
datacenter.
After you finish
After all of the scale-out vApp VMs have been deployed and added to the ViPR SRM
vApp container, follow these steps to complete the configuration:
1. Edit the ViPR SRM vApp container settings.
2. Modify the start order of the vApp entities as described in Modify start order of
vApps.
3. Adjust the VM memory, CPU settings, and Additional Storage for each of the VMs
as described in your EMC ViPR SRM design specification.
4. Power off the vApp container. All of the VMs will perform a Guest Shutdown in the
reverse startup order
5. Power on the ViPR SRM vApp container. Right click the vApp and select Power
On.
A built-in service detects the new VMs and performs the needed configurations to add
the scale-out VM to the exisiting SRM installation.

Deploying Collector vApp VMs in different datacenters
Use this procedure to deploy remote Collectors in different datacenters.
Procedure
1. Navigate to the Support by Product page for ViPR SRM (https://
support.emc.com/products/34247_ViPR-SRM).
2. Click Downloads.
3. Download the ViPR SRM <version number> vApp Deployment zip file.
Each download has a checksum number. Copy the checksum number and
validate the integrity of the file using an MD5 checksum utility.
The host being connected to the vCenter should be local to the ESX servers for
the quickest deployment. Locate the 1VM OVF deployment file on the host
running the vCenter client or place the files on the DataStore.
4. Open the vCenter Client and connect to the vCenter Server that manages your
VMware environment.
5. Select File > Deploy OVF Template.
6. In the Source step, locate the 1VM OVF file.
7. Click Next.
8. In the OVF Template Details step, review the details of the loaded .ovf file, and
click Next.
9. In the End User License Agreement step, review the license agreement. Click
Accept, and then click Next.
10. In the Name and Location step:
a. Specify a new name or accept the default name for the appliance.
b. In the Inventory Location, select the Datacenter and sub-location where the
appliance will be deployed. Navigate through the folder levels to define the
exact location.
14
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c. Click Next.
11. In the Deployment Configuration step, select the Collector Appliance from the
drop-down menu.
12. In the Host/Cluster step, select the ESX server or ESX Cluster, and click Next.
13. In the Resource Pool step, select the Resource Pool or the folder where the
deployment will place the ViPR SRM VMs, and click Next.
14. In the Storage step, select the DataStore for the virtual machine files, and then
click Next.
15. In the Disk Format step, select the storage space provisioning method, and
then click Next.
Option

Description

Thin-provisioned format On-demand expansion of available storage, used for
newer data store file systems.
Thick-provisioned
format

Appliance storage that is allocated immediately and
reserved as a block.

16. In the Network Mapping step, select a destination network for the VM, and
then click Next.
17. In the IP Address Allocation step, choose the Fixed IP allocation policy and the
IP protocol to use, and then click Next.
18. In the Properties step, provide the values for each field, and then click Next.
19. In the Ready to Complete step, review the list of properties for the appliance,
and then click Finish.
A pop-up menu that shows the deployment progress opens in vCenter Client.
20. After the deployment finishes, in the Deployment Completed Successfully
dialog box, click Close.
21. Repeat these steps for each Collector that you need to install in a remote
datacenter.
22. If you are adding a remote collector that is deployed in a remote datacenter to
the ViPR SRM vApp, use the steps for adding a collector that are described in
Adding Remote Collectors to the existing ViPR SRM deployment. These steps
will finish the collector configuration and add the collector to the ViPR SRM UI.
After you finish
For Collectors installed in a remote datacenter, you will need to use the ViPR SRM UI
to make some configuration changes to the Load Balancer Connectors, generic-rsc,
and generic-snmp installed on each Collector.

Post deployment, pre-startup tasks
After you have deployed the vApp VMs, but before you start ViPR SRM, you must
make some configuration changes as specified in the ViPR SRM design provided by
EMC.
Procedure
1. Complete the following configuration changes:

Post deployment, pre-startup tasks

15

Installing the Virtual Appliance

l

Adjust the Collector VM memory

l

Adjust the Collector VM CPUs

l

Change the vApp VM name in vCenter to conform to naming policies

l

Increase the VM storage per VM

l

Move the vApp VM storage to its assigned datastore

l

Modify the vApp container startup order

Adjusting the VMs
The Collectors (and possibly the Frontend) will need the number of CPUs, the size,
and the memory adjusted based on the EMC ViPR SRM design. Edit the settings of
each Collector vApp VM to make these adjustments.
Procedure
1. The vApp VMs may need the default VM name changed to meet VM naming
standards. Edit the VM settings and select the Options tab to make these
changes.

Adding disk space
All vApp VMs are deployed with 132GB of storage. Each ViPR SRM VM will need larger
storage. The total ViPR SRM VM storage size is based on the EMC ViPR SRM design.
Edit the settings of each vApp VM and add a new VMDK (virtual machine disk).
Subtract 132GB from the total storage size specified in the sizing plan provided by
EMC, and add a new VMDK (virtual machine disk) with the size of the additional
storage needed. The VM can be running during this process.
Procedure
1. From the vCenter Console, select the individual VM where you want to add new
disk storage.
2. Select Edit Settings on the virtual machine and click Add.
3. Select Hard Disk and click Next .
4. Select Create a new virtual disk and click Next.
5. Specify the disk size, the provisioning type, the location of the disk and click
Next.
6. Specify the virtual device node (the default value should be OK) and click Next.
7. Review the options and click Finish.
8. After ViPR SRM is up and running, putty to the Linux host. You can access a
login prompt through the vCenter Client console or using an SSH tool such as
PuTTY.
9. At the root system prompt, type the command expand_disk.pl.
The script will merge the new VMDK with the existing files system while the VM
is still running. Use the df -h command when the script is finished to see the
new filesystem size.

16
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DataStores
The 4VM vApp deployment places the 4 VMs on a single DataStore. Migrate the VM
from this DataStore to its assigned DataStore. The required storage per ViPR SRM
VM can be found in the design provided by EMC.
For reference, the target storage sizes are as follows:
l

Frontend – 320 GB

l

Primary Backend – 800 GB and larger

l

Additional Backends – 1 TB and larger

l

Collector – 300 GB or larger

With the VM in a powered off state, use the Storage vMotion feature to move the VM
to a new DataStore.

Modifying the start order of the vApps
Modify the start order of the vApps in a ViPR SRM installation whenever you add a
vApp VM to the vApp container.
Procedure
1. Right click the vApp and select Edit Settings.
2. Navigate to the Start Order tab.
3. Move the new VMs into the proper group based on the following:
l

Group 1: All Additional Backends

l

Group 2: Primary Backend

l

Group 3: All Collectors

l

Group 4: Frontend

4. In the Shutdown Action section, select Guest Shutdown from the Operation
list.
5. Change the elapsed time to 600 seconds.
6. Click OK.

DataStores
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Starting the vApp
The ViPR SRM startup order is controlled by the vApp container settings
Before you begin
Edit the start-up as described in Post deployment, pre-startup tasks.
Always start and stop the vApp using the vApp container. Do not stop any of the
individual VMs inside the vApp container. You can start and stop Remote Collectors in
other datacenters independently. Use vCenter Client to start the vApp.
The initial startup of ViPR SRM will not be ready for login for about 10 minutes after
the VMs are show as started in vCenter because an internal configuration process to
configure each VM must complete. You can monitor this process by opening the
vCenter Console for the VM.
Procedure
1. ViPR SRM will be ready for login after the additional background processing
completes. The URL for logging in is http://hostname:58080/APG or
http://hostname/APG.

Passwords
Passwords control access to ViPR SRM and the internal communications.
The web-based user passwords are managed through the Administration user
interface. The ViPR SRM internal communications passwords are managed through
the Centralized Management > Central Configuration Repository. For additional
details, refer to Security Configuration Guide.
Table 1 Default usernames and passwords

Environment

Username and password

Web-based console accessed in a browser

admin/changeme Ensure that you change
this password.

Linux guest OS appliance console accessed
through SSH or vCenter

root/Changeme1!

If you choose to change the root user password, the password must conform to the
following requirements.:
l

Be at least eight characters and no more than 40 characters

l

Contain at least one numeric character

l

Contain at least one uppercase and one lowercase character

l

Contain at least one non-alphanumeric character such as # or !

l

Cannot contain the single quote character (') because it is a delimiter for the
password string

Note

The web-based requirements do not apply to Linux passwords.
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Verifying that the services are running
Verify that the services are running on each host by obtaining the status.
Before you begin
Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the application uses instead of root.
Procedure
1. Type the command for your operating system from the bin directory of the
installation:
Operating system

Command

UNIX

manage-modules.sh service status all

Windows

manage-modules.cmd service status all

2. Verify that each service has a status of running in the output.

Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.
Before you begin
Ensure that you have logged in with root to check the log files.
Procedure
l

The default path is /opt/APG/.
The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).
Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log

Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet your needs
Procedure
1. Open a browser and type the following URL:
http://<Frontend-hostname>:58080/APG
2. Type the login credentials.
The default username is admin. The default password is changeme.
3. Click Sign In.
Verifying that the services are running
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Note

You are automatically logged off after four hours.

Reconfiguring the LBC, generic-snmp, and generic-rsc
If a collector is powered on outside of the vApp, you must reconfigure the Load
Balancer Connector, generic-snmp, and generic-rsc.
Procedure
1. From Centralized Management, click SolutionPacks.
2. Under Other Components, click the Reconfigure icon for a Load Balancer
Connector for each remote Collector. Use the following settings:
l

Arbiter Configuration: send data to the Primary Backend over port 2020.

l

Alerting on data collection: send data to the Primary Backend over port
2010.

l

Frontend Web service: send data to the Frontend over port 58080.

3. Repeat these steps for each remote Collector's Load Balancer Connector.
4. Under Other Components, click the Reconfigure icon for a generic-snmp or
generic-rsc instance. Use the following settings:
l

Data Configuration: send data to the localhost over port 2020.

l

Frontend Web service: send data to the Frontend over port 58080.

l

Topology Service: send data to the Primary backend.

5. In the SNMP Collector Name field, enter the FQDN of the collector host.
6. Repeat the steps for each instance of generic-snmp and generic-rsc.

Verifying DB Grants
After installing and configuring the ViPR SRM hosts, you can cross check the grant
privileges configured for the ViPR SRM servers that are listed in the Scale Tools
configuration file.
Database grants for Collector hosts are not required.
Where the scripts configure grants for Collector hosts, these are not needed and can
be ignored or deleted.
Procedure
1. Run the following script:
/opt/APG/bin/mysql-client.sh

2. When prompted, select root as the username, mysql for the database, and
watch4net as the password.

22

EMC ViPR SRM 4.0.2 Installation and Configuration Guide

Working with the vApp

3. Run the following query:
mysql> SELECT user, host, db, select_priv, insert_priv,
grant_priv FROM mysql.db;

The following table is an example of the configuration you should see on an Additional
Backend host:

Verifying DB Grants
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l
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Creating the Scale Tools answers file.................................................................26
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Scale Tools
Scale Tools is a package that can be installed on each of the ViPR SRM servers. Use
the Scale Tools scripts to configure the VMs for a Binary Deployment and for
additional remote Collectors installed in remote datacenters. The Scale Tools are
provided with ViPR SRM 4.0.1 and later. All previous version of ViPR SRM Scale Tools
are incomplete and will fail.
The Scale Tools scripts use an answers file to automatically configure the ViPR SRM
servers. You can use the Scale Tools for the following scenarios:
l

Initial configuration of a Frontend, Primary Backend, and Additional Backend
servers

l

Adding new Additional Backend servers to an existing ViPR SRM environment

Before you begin, deploy all of the Collectors in all of the remote datacenters. They
can be Collector vApps, or binary Linux or Windows Collectors.
Binary Collectors are installed using the "Collector" install option for both Linux and
Windows. A Collector configuration script in Scale Tools finishes the Collector
configuration so that it is the same as a vApp collector.
If a Scale Tools script configuration fails, you cannot run the script a second time. If
the configuration fails, you must clean ViPR SRM from the server and reinstall ViPR
SRM. Refer to Uninstallation.
If you are using vCenter Snaphots, power down the VM and take a snapshot before
running the scale-tools script.

Creating the Scale Tools answers file
Scale Tools is a command-line utility that can configure and add a single server or
multiple servers to your ViPR SRM environement. Scale Tools uses an answers file
that you create that includes all of the servers in all of the datacenters in your ViPR
SRM environment.
Before you begin
l

The answers file is case sensitive and must be all lowercase.

l

Create the file using notepad++ or the Linux vi editor.

l

Name the file Scale-config.

The format of the answers file is: server_type=hostname:os
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Definition

Description

server_type

The four basic types of ViPR SRM servers

hostname

The server's FQDN. It match the setting of
the hostname variable in the
apg.properties file. For Linux servers, this
should always be the hostname plus the
domain name (FQDN). For Windows, this
could be the hostname (shortname) or the
FQDN depending on how the Windows server
resolution is configured (DNS, Active DNS, or
Wins/NetBios). A Wins resolution will use the
hostname (shortname) in uppercase.
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Definition

Description

OS

linux-x64 or windows-x64

For example:
frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
collector_1=lglba150.lss.emc.com:linux-x64

This initial answers file can be modified later to add any new Collectors and Additional
Backends. When the Scale Tools scripts run, they distinguish new servers from
existing servers and make the necessary configuration changes.
Because the Scale Tools and the answers file can be used for configuring additional
servers, EMC recommends storing the files in a /sw directory in the / directory to
prevent the files from being deleted from the /tmp directory.

Creating the Scale Tools answers file
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Adding remote Collectors to the existing ViPR SRM
deployment.
When you add a vApp Collector VM, it is completely configured as a Collector host
with all of the components. You can add the Collector through Centralized
Management > Configuration > Server > Register a Server. If you have multiple
remote vApp collectors, you can use the launch-frontend-scalecollector.sh -c /sw/Scale-config script to register the Collectors.
Database grants for Collector hosts are not required.
Use the following procedure to add a binary Collector VM.
Note

For Windows, use .cmd instead of .sh, and / instead of \ for directories.
Procedure
1. Configure the Linux and Windows binary collectors:
a. Install the Scale Tools:
manage-modules.sh install scale-tools

b. Navigate to cd /opt/APG/bin.
c. Run the Collector configuration script:
launch-collector-configuration.sh –c /sw/Scale-config

d. Verify that all of the services are running:
manage-modules.sh service status all

2. On the Frontend, run the following command:
launch-frontend-scale-collector.sh -c /sw/Scale-config

3. Verify the Remote Collector configuration through the ViPR SRM UI.

Reconfiguring the LBC, generic-snmp, and generic-rsc
If a collector is powered on outside of the vApp, you must reconfigure the Load
Balancer Connector, generic-snmp, and generic-rsc.
Procedure
1. From Centralized Management, click SolutionPacks.
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2. Under Other Components, click the Reconfigure icon for a Load Balancer
Connector for each remote Collector. Use the following settings:
l

Arbiter Configuration: send data to the Primary Backend over port 2020.

l

Alerting on data collection: send data to the Primary Backend over port
2010.

l

Frontend Web service: send data to the Frontend over port 58080.

3. Repeat these steps for each remote Collector's Load Balancer Connector.
4. Under Other Components, click the Reconfigure icon for a generic-snmp or
generic-rsc instance. Use the following settings:
l

Data Configuration: send data to the localhost over port 2020.

l

Frontend Web service: send data to the Frontend over port 58080.

l

Topology Service: send data to the Primary backend.

5. In the SNMP Collector Name field, enter the FQDN of the collector host.
6. Repeat the steps for each instance of generic-snmp and generic-rsc.

Reconfiguring the LBC, generic-snmp, and generic-rsc
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Install options for standard installation
Learn how to install the platform using a binary installation package.
The platform infrastructure consists of four types of hosts:
l

Frontend host

l

Backend hosts (Primary and Additional)

l

Collector host

l

All-In-One (recommended for testing only)

You can only have one Primary Backend host. You can add Additional Backend hosts
with up to four Time-Series databases on each.
For deployments to support 5 million metrics or more, EMC recommends deploying
the Frontend, Primary Backend and Additional Backend hosts on the Linux operating
system.
The MySQL version included with the product is 5.5.48 MySQL Community Server
(GPL).
Table 2 Installation Options

Frontend

Primary
Backend

Additional
Backend

Collector

Linux Installation
Options

[f]rontend

[b]ackend

[m]inimal

[c]ollector

Windows
Installation
Options

Frontend
Modules

Backend
Modules

Base Installation Collector
(with none of the Modules
modules
selected)

General ViPR SRM requirements
These requirements are for a minimal deployment. In a production environment, the
requirements will vary depending on the provisioned load, and you must include careful
planning and sizing before beginning the deployment.
The ViPR SRM Planner and the EMC ViPR SRM Performance and Scalability Guidelines
document associated with your specific release will provide guidance for
SolutionPacks and object discovery.
For details about configuring CA SSL certificates, refer to the EMC M&R Security
Configuration Guide.
The environment must meet the following requirements:
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l

64 bit operating system (Linux or Windows)

l

16 to 24 GB RAM for each host

l

Frontend – 16 GB RAM, 320 GB disk storage

l

Backends – 24 GB RAM, disk storage is determined by the sizing

l

Collectors – 16+ GB RAM, 130+ GB disk storage
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l

4 CPUs per host

l

Forward and Reverse IP and DNS lookups must work on each server

Note

The following sections use Linux commands and directories as examples. For
Windows, use .cmd instead of .sh, and / instead of \ for directories.

Linux requirements
The environment must meet the following requirements. Make adjustments to the
host before continuing.
l

/tmp folder larger than 2.5 GB

l

SWAP file should be at least equal to the RAM size

l

On CentOs or RedHat-like Linux, the SELinux should be disabled or reconfigured

l

The graphical desktop environment is not required

l

On some Linux distributions:
n

MySQL server requires libaio1, libaio-dev, or libaio to start

n

The installation process requires unzip

n

On system restart the apg services may not start

Installing on Linux
You can install the product on supported UNIX hosts. This procedure specifically uses
the Linux installation procedure as an example.
Before you begin
l

Ensure that you have a login with root privileges. This product should only be
installed using root and root privileges.

l

Ensure that the ports listed in the Ports Usage Matrix are enabled and not blocked
by a host or network firewall.
Refer to Updating firewall ports in Red Hat and CentOS servers.

l

Download the installation file from support.emc.com, and place it in a folder
(for example /sw) on the server.

These instructions are meant to provide a high-level overview of the installation
process. Detailed instructions are provided in the following sections.
Procedure
1. Log in to the server as root.
2. Navigate to the /sw folder.
3. Change the permissions of the installer.
For example: chmod +x <file_name>.sh
4. Run the installer from the directory.
For example: ./<file_name>.sh
5. Read and accept the End User License Agreement.
Linux requirements
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6. Accept the default installation directory of /opt/APG or type another location.
7. Select the appropriate installation option for the type of host that you are
installing. Refer to Installation Options for details.

Configuring the user process limits for a Linux installation
Increase the user process limits for the apg user account to a maximum of 65534. This
modification enables services to open 65534 files and 65534 processes when needed.
This step is required for proper functioning of the core software.
Before you begin
l

Make sure you have a login with root privileges.

l

The core software installed on a server running Red Hat Enterprise Linux 6,
CentOS Linux 6, SUSE Linux Enterprise Server (SLES) 11, or any other supported
Linux operating systems.

Procedure
1. Edit (vi) the /etc/security/limits.conf file.
2. Insert the following lines for the apg user after the line that starts with
<domain>.
In this example, the user is apg.
apg
apg
apg
apg

hard
soft
hard
soft

nofile
nofile
nproc
nproc

65534
65534
65534
65534

3. Save the file.
4. To verify the changes, type the following command:
su apg -c 'ulimit -n -u'
open files
max user processes

(-n) 65534
(-u) 65534

5. In the /opt/APG/bin/apg.properties file, verify that the hostname is a
FQDN host name. If the hostname is a shortname, edit (vi) the file to change
the hostname to a FQDN.
6. In the /etc/hosts file, verify that the first uncommented line is this host's IPaddress, FQDN, and shortname. If this is not first uncommented line, edit the
file.
7. STOP: Repeat the ViPR SRM installation and configuration process for all of
the servers in this deployment before proceeding.
8. To restart the services, type the following commands from the /opt/APG/bin
directory of the installation. Troubleshoot any service that does not show a
status of “running.”
./manage-modules.sh service restart all
./manage-modules.sh service status all
9. Proceed to Configuring Binary ViPR SRM using Scale Tools.
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Installing on Windows Server
You can install the product on supported Windows Server hosts.
Before you begin
l

Ensure that the \tmp folder is larger than 2.5 GB.

l

Ensure that you have a login with system administrator privileges.

l

Ensure that the ports listed in the Ports Usage Matrix are enabled and not blocked
by the firewall.

l

Download the installation file from support.emc.com, and place it in a folder
(for example, c:\sw) on the server.

These instructions are meant to provide a high-level overview of the installation
process. Detailed instructions are provided in the following sections.
Procedure
1. Navigate to the c:\sw folder.
2. Double-click the .exe file.
3. Click Next on the Welcome screen.
4. Read and accept the End User License Agreement. Click I Agree.
5. Select the Destination Folder, and then click Next.
6. Select the appropriate installation option for the type of host that you are
installing. Refer to Installation Options for details.
7. Click Install.
8. When the installation is complete, click Next.
9. Click Finish.
10. In the Program Files\APG\bin\apg.properties file, verify that the
hostname is a FQDN host name. If the hostname is a shortname, edit the file to
change the hostname to a FQDN.
11. In the c:\windows\System32\drivers\etc\hosts file, verify that the
first uncommented line is this host's IP-address, FQDN, and shortname. If this is
not first uncommented line, edit the file.
12. STOP: Repeat the ViPR SRM installation and configuration process for all of
the servers in this deployment before proceeding.
13. Restart the services, and troubleshoot any service that does not show a status
of “running.”
manage-modules.cmd service restart all
manage-modules.cmd service status all

Configuring virus-scanning software
Running virus-scanning software on directories containing MySQL data and temporary
tables can cause issues, both in terms of the performance of MySQL and the virusscanning software misidentifying the contents of the files as containing spam.
After installing MySQL Server, it is recommended that you disable virus scanning on
the directory used to store your MySQL table data (such as C:\Program Files
Installing on Windows Server
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\APG\Databases\MySQL\Default\data). In addition, by default, MySQL creates
temporary files in the standard Windows temporary directory. To prevent scanning the
temporary files, configure a separate temporary directory for MySQL temporary files
and add this directory to the virus scanning exclusion list. To do this, add a
configuration option for the tmpdir parameter to your my.ini configuration file.

Configuring Binary ViPR SRM Scale Tools
Scale Tools is a package provided with ViPR SRM 4.0.1 and later that can be installed
on each ViPR SRM server. These tools provide configuration scripts to automate the
configuration the ViPR SRM components and link the servers together. The scripts
are in the <installation directory>/APG/bin folder. The Scale Tools are
capable of configuring the VIPR SRM environment for both Linux and Windows
servers.
Note

The scale tools provided with ViPR SRM 3.7 and ViPR SRM 4.0 will not work.
The Scale Tools scripts use an answers file to automatically configure the ViPR SRM
servers. You can use the Scale Tools for the following scenarios:
l

Initial configuration of a Frontend, Primary Backend, and Additional Backend
servers

l

Adding new Additional Backend servers to an existing ViPR SRM environment

l

Configuring the Collector to connect to the core ViPR SRM servers

If a Scale Tools script configuration fails, you cannot run the script a second time. If
the configuration fails, you must clean ViPR SRM from that VM/Server and reinstall
the product. Refer to Uninstallation.

Creating the Scale Tools answers file
Scale Tools is a command-line utility that can configure and add a single server or
multiple servers to your ViPR SRM environement. Scale Tools uses an answers file
that you create that includes all of the servers in all of the datacenters in your ViPR
SRM environment.
Before you begin
l

The answers file is case sensitive and must be all lowercase.

l

Create the file using notepad++ or the Linux vi editor.

l

Name the file Scale-config.

The format of the answers file is: server_type=hostname:os
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Definition

Description

server_type

The four basic types of ViPR SRM servers

hostname

The server's FQDN. It match the setting of
the hostname variable in the
apg.properties file. For Linux servers, this
should always be the hostname plus the
domain name (FQDN). For Windows, this
could be the hostname (shortname) or the
FQDN depending on how the Windows server
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Definition

Description
resolution is configured (DNS, Active DNS, or
Wins/NetBios). A Wins resolution will use the
hostname (shortname) in uppercase.

OS

linux-x64 or windows-x64

For example:
frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
collector_1=lglba150.lss.emc.com:linux-x64

This initial answers file can be modified later to add any new Collectors and Additional
Backends. When the Scale Tools scripts run, they distinguish new servers from
existing servers and make the necessary configuration changes.
Because the Scale Tools and the answers file can be used for configuring additional
servers, EMC recommends storing the files in a /sw directory in the / directory to
prevent the files from being deleted from the /tmp directory.

Installing and configuring the Primary Backend hosts
Learn how to install and configure the Primary Backend hosts.
Before you begin
l

Identify the host you want to configure as the Primary Backend host.

l

Identify the hosts you want to configure as the Frontend, Collectors, and
Additional Backends.

l

Ensure that you have created an answers file as described in Creating the Scale
Tools answers file.

l

Minimum System Requirements:
n

CPU: 4

n

Memory: reference the server type

n

Disk Space: 120 GB (the final storage size per server will be adjusted later)

Procedure
1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX.
2. Navigate to /opt/APG/bin.
3. Install the Scale Tools:
manage-modules.sh install scale-tools

4. Run the Primary Backend configuration script:
launch-primarybackend-configuration.sh –c /sw/Scale-config

Installing and configuring the Primary Backend hosts
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5. Verify that all of the services are running. Troubleshoot any service that does
not show a status of “running.”
manage-modules.sh service status all

6. Check the DB grants as described in Verifying DB grants.

Installing and configuring the Additional Backend hosts
Learn how to install and configure the Additional Backend host.
Before you begin
l

Identify the host you want to configure as the Additional Backend host.

l

Identify the hosts you want to configure as the Frontend, Collectors, Primary
Backends, and Additional Backends.

l

Ensure that you have created an answers file as described in Creating the Scale
Tools answers file.

l

Minimum System Requirements:
n

64-bit Operating System

n

CPU: 4

n

Memory: reference the server type

n

Disk Space: 120 GB (the final storage size per server will be adjusted later)

Procedure
1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on Linux.
2. Navigate to /opt/APG/bin.
3. Install the Scale Tools:
manage-modules.sh install scale-tools

4. Run the Additional Backend configuration script:
launch-additionalbackend-configuration.sh –c /sw/Scale-config

5. Verify that all of the services are running. Troubleshoot any service that does
not show a status of “running.”
manage-modules.sh service status all

6. Check the DB grants as described in Verifying DB grants.
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Installing and configuring the Collector host
Learn how to install and configure the Collector host.
Before you begin
l

Identify the hosts you want to configure as the Collector hosts.

l

Ensure that you have created an answers file as described in Creating the Scale
Tools answers file.

l

Minimum System Requirements:
n

64 bit operating system (Linux or Windows)

n

CPU: 4

n

Memory: reference the server type

n

Disk Space: 120 GB (the final storage size per server will be adjusted later)

Procedure
1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX or Installing on Windows Server.
2. Navigate to .../APG/bin.
3. Install the Scale Tools:
manage-modules.sh install scale-tools

4. Run the Collector configuration script:
launch-collector-configuration.sh –c /sw/Scale-config

5. Verify that all the services are running. Troubleshoot any service that does not
show a status of “running.”
manage-modules.sh service status all

6. The Generic-RSC and Generic-SNMP modules will be installed by default. If you
do not plan to use this collector for host discovery or SNMP discovery, you can
choose to remove these modules. To remove these modules:

/.../APG/bin/manage-modules.sh remove generic-snmp

Installing and configuring the Frontend host
Learn how to install and configure the frontend host.
Before you begin
l

Ensure that you have the details of the Frontend host.
Installing and configuring the Collector host
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l

Ensure that you have created an answers file as described in Creating the Scale
Tools answers file.

l

Minimum System Requirements:
n

64-bit Operating System

n

CPU: 4

n

Memory: 16 GB

n

Disk Space: 120 GB (the final storage size per server will be adjusted later)

Procedure
1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on Linux.
2. Navigate to /opt/APG/bin.
3. Install the Scale Tools:
manage-modules.sh install scale-tools

4. Run the Frontend configuration script:
launch-frontend-configuration.sh –c /sw/Scale-config

During the Frontend configuration the management-resources are configured
on the Primary Backend server. If the ViPR SRM ports are not open, then this
configuration script will fail with this error: "Some operations failed to execute
successfully." Review the logs and fix any errors manually. Refer to Adding Red
Hat and CentOS server firewall ports to establish the ViPR SRM ports on all the
ViPR SRM servers. Do not attempt to run this script again. You must remove
ViPR SRM from the server where you were running the script and reinstall ViPR
SRM. Refer to Uninstallation.
5. Verify that all the services are running:
manage-modules.sh service status all

6. Verify that the ViPR SRM management resources have been created:
/opt/APG/bin/manage-resources.sh list

The following is an example of the management resources that would be
created for a four server ViPR SRM environment:
"dba/APG-DB",
"dba/APG-DB-lglac142-1",
"dba/APG-DB-lglac142-2",
"dba/APG-DB-lglac142-3",
"dba/APG-DB-lglac142-4",
"dba/FLOW-COMPLIANCE-BREACH",
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Scaling-out a ViPR SRM environment with Additional
Backend hosts
To scale-out the existing ViPR SRM environment with Additional Backends servers,
use the Scale Tools to automate the configuration. When adding Additional Backend
servers, the Scale Tools scripts adds new servers to the existing ViPR SRM
environment.
Before you begin
l

Identify the host you want to configure as the Additional Backend host.

l

Get the details of the existing ViPR SRM environment that you want to scale.

l

Minimum System Requirements:
n

64-bit Operating System

n

CPU: 4

n

Memory: 12 or 16 GB

n

Disk Space: 120 GB (the final storage size per server will be adjusted later)

Note

For Windows convert .sh to .cmd for the commands and / to \ for directories.
Procedure
1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX.
2. Navigate to /opt/APG/bin.
3. Install the Scale Tools:
manage-modules.sh install scale-tools

4. Modify the Scale Tools answer file (Scale-config) as described in Creating
the Scale Tools answers file
5. Add the new Additional Backend to the Scale-config file.
In the example below, additionalbackend_2 is the new Additional Backend.
frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
additionalbackend_2=lglac143.lss.emc.com:linux-x64
collector_1=lppd149.lss.emc.com:linux-x64

6. Push the new answer file (Scale-config) to the ViPR SRM Frontend,
Primary Backend, and Additional Backends. (This new file is not needed on the
existing Collector servers.)
7. Navigate to /opt/APG/bin.

Scaling-out a ViPR SRM environment with Additional Backend hosts
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8. Run the following script to configure the new Additional Backend host:
launch-additionalbackend-configuration.sh –c /sw/Scale-config

9. Verify that all the services are running:
manage-modules.sh service status all

10. Run the following script on all Additional Backend servers:
launch-additionalbackend-scale-additionalbackend.sh –c / sw/
Scale-config

11. Run the following script on the Primary Backend server:
launch-primarybackend-scale-additionalbackend.sh –c / sw/
Scale-config

12. Run the following script on the Master Frontend server:
launch-frontend-scale-additionalbackend.sh –c / sw/Scaleconfig

13. List the Management Resources to verify that the Additional Backends servers
were added:
manage-resources.sh list

14. Restart all of the services on the Additional Backend servers, Primary Backend
server, and Frontend Server.
15. Log in to ViPR SRM and confirm that the new Additional Backend is in the UI.

Scaling-out a ViPR SRM environment with Collector hosts
To scale-out the existing ViPR SRM environment with new collector hosts, use the
Scale Tools to automate the configuration. When adding collector hosts, the Scale
Tools scripts adds new servers to the existing ViPR SRM environment.
Before you begin
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l

Identify the host you want to configure as the Collector host.

l

Get the details of the existing ViPR SRM environment that you want to scale.

l

Minimum System Requirements:
n

64-bit Operating System

n

CPU: 4

n

Memory: 24 GB
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n

Disk Space: 120 GB (the final storage size per server will be adjusted later)

Note

For Windows, convert .sh to .cmd for the commands and / to \ for directories.
Procedure
1. The base ViPR SRM software and OS modifications should already be
completed as described in Installing on UNIX or Installing on Windows Server.
2. Navigate to .../APG/bin.
3. Install the Scale Tools:
manage-modules.sh install scale-tools

4. If you have not already, modify the Scale Tools answer file (Scale-config) as
described in Creating the Scale Tools answers file.
5. Add the new collector to the Scale-config file.
In the example below, collector_2 is the new Collector.
frontend=lglba148.lss.emc.com:linux-x64
primarybackend=lglba224.lss.emc.com:linux-x64
additionalbackend_1=lglac142.lss.emc.com:linux-x64
additionalbackend_2=lglac143.lss.emc.com:linux-x64
collector_1=lppd149.lss.emc.com:linux-x64
collector_2=lglba150.lss.emc.com:linux-x64

6. Push the new answer file (Scale-config) to the ViPR SRM Frontend,
Primary Backend, and Additional Backends. (This new file is not needed on the
existing Collector servers.)
7. Navigate to .../APG/bin.
8. Run the following script to configure the new Collector host:
launch-collector-configuration.sh –c /sw/Scale-config

9. Verify that all the services are running:
Option

Description

Linux

manage-modules.sh service status all

Windows

manage-modules.cmd service status all

10. Run the following script on each Frontend:
launch-frontend-scale-collector.sh –c / sw/Scale-config

11. Log in to ViPR SRM and confirm that the new Collector is in the UI.

Scaling-out a ViPR SRM environment with Collector hosts
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Verifying DB Grants
After installing and configuring the ViPR SRM hosts, you can cross check the grant
privileges configured for the ViPR SRM servers that are listed in the Scale Tools
configuration file.
Database grants for Collector hosts are not required.
Where the scripts configure grants for Collector hosts, these are not needed and can
be ignored or deleted.
Procedure
1. Run the following script:
/opt/APG/bin/mysql-client.sh

2. When prompted, select root as the username, mysql for the database, and
watch4net as the password.
3. Run the following query:
mysql> SELECT user, host, db, select_priv, insert_priv,
grant_priv FROM mysql.db;

The following table is an example of the configuration you should see on an Additional
Backend host:
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Updating firewall ports in Red Hat and CentOS servers
The Red Hat and CentOS operating systems are installed by default with the OS
firewall (firewalld) locked down. Only a few basic ports are open (such as SSH). On
these operating systems, the firewall must be modified to allow the ViPR SRM ports.
Procedure
1. Using a Linux editor, create an xml file and save it as apg.xml in the /etc/
firewalld/services directory.
2. Add the following text to the xml file:
<?xml version="1.0" encoding="utf-8"?>
<service>
<short>TEST</short>
<description>Add ViPR SRM Ports to Red Hat and CentOS
Firewall</description>
<port protocol="tcp" port="58080"/>
<port protocol="tcp" port="2000"/>
<port protocol="tcp" port="2001"/>
<port protocol="tcp" port="2100"/>
<port protocol="tcp" port="2101"/>
<port protocol="tcp" port="2200"/>
<port protocol="tcp" port="2201"/>
<port protocol="tcp" port="2300"/>
<port protocol="tcp" port="2301"/>
<port protocol="tcp" port="2400"/>
<port protocol="tcp" port="2401"/>
<port protocol="tcp" port="2003"/>
<port protocol="tcp" port="2008"/>
<port protocol="tcp" port="2009"/>
<port protocol="tcp" port="2010"/>
<port protocol="tcp" port="2012"/>
<port protocol="tcp" port="2020"/>
<port protocol="tcp" port="2022"/>
<port protocol="tcp" port="2040"/>
<port protocol="tcp" port="2041"/>
<port protocol="tcp" port="5480"/>
<port protocol="tcp" port="5488"/>
<port protocol="tcp" port="5489"/>
<port protocol="tcp" port="8082"/>
<port protocol="tcp" port="8189"/>
<port protocol="tcp" port="8888"/>
<port protocol="tcp" port="8889"/>
<port protocol="tcp" port="9996"/>
<port protocol="tcp" port="22000"/>
<port protocol="tcp" port="22020"/>
<port protocol="tcp" port="22020"/>
<port protocol="tcp" port="48443"/>
<port protocol="tcp" port="52001"/>
<port protocol="tcp" port="52004"/>
<port protocol="tcp" port="52007"/>
<port protocol="tcp" port="52569"/>
<port protocol="tcp" port="52755"/>
<port protocol="tcp" port="53306"/>
<port protocol="tcp" port="58005"/>
<port protocol="tcp" port="389"/>
<port protocol="tcp" port="58443"/>
<port protocol="tcp" port="5988"/>
<port protocol="tcp" port="5989"/>
<port protocol="tcp" port="5986"/>
<port protocol="tcp" port="80"/>
<port protocol="tcp" port="443"/>
<port protocol="tcp" port="8080"/>

Updating firewall ports in Red Hat and CentOS servers
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<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="tcp"
<port protocol="udp"
<port protocol="udp"
<port protocol="udp"
<port protocol="udp"
</service>

port="2707"/>
port="8443"/>
port="2443"/>
port="4443"/>
port="2682"/>
port="1521"/>
port="9004"/>
port="9002"/>
port="7225"/>
port="58083"/>
port="52755"/>
port="2060"/>
port="3682"/>
port="161"/>
port="162"/>
port="2040"/>
port="2041"/>

3. Copy the apg.xml file to the /etc/firewalld/services directory.
4. Run the following command to add the ports to the existing firewall:
firewall-cmd --permanent --add-service=apg

5. Check the status of firewalld:
systemctl status firewalld

Editing new actions scripts
Edit actions on the frontend host to send events to the machine on which the eventprocessing-manager of the alerting-consolidation module is configured.
Procedure
1. In the following file, replace 127.0.0.1 with the primary backend IP address:
Option

Description

Linux

/opt/APG/Custom/WebApps-Resources/Default/
actions/event-mgmt/linux/conf

Windows Program Files\APG\Custom\WebApps-Resources
\Default\actions\event-mgmt\windows\conf.cmd

Verifying that the services are running
Verify that the services are running on each host by obtaining the status.
Before you begin
Ensure that you have a login with root, APG, or system administrator privileges. The
user apg is the account that the application uses instead of root.
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Procedure
1. Type the command for your operating system from the bin directory of the
installation:
Operating system

Command

UNIX

manage-modules.sh service status all

Windows

manage-modules.cmd service status all

2. Verify that each service has a status of running in the output.

Troubleshooting service start-up problems on UNIX
Check the log files when services do not start.
Before you begin
Ensure that you have logged in with root to check the log files.
Procedure
l

The default path is /opt/APG/.
The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).
Databases/MySQL/Default/data/[SERVER NAME].err
Backends/Alerting-Backend/Default/logs/alerting-0-0.log
Backends/APG-Backend/Default/logs/cache-0-0.log
Collecting/Collector-Manager/Default/logs/collecting-0-0.log
Web-Servers/Tomcat/Default/logs/service.log
Tools/Task-Scheduler/Default/logs/scheduler-0-0.log
Tools/Webservice-Gateway/Default/logs/gateway-0-0.log

Troubleshooting service start-up problems on Windows
Check the log files when services do not start.
Before you begin
Ensure that you have logged in with system administrator credentials to check the log
files.
Procedure
l

Look for log files in these C:\Program Files\APG directory paths.
The list of available log files will vary depending on the type of server (Frontend,
Backend, or Collector).
Databases\MySQL\Default\data\[SERVER NAME].err.
Backends\Alerting-Backend\Default\logs\alerting-0-0.log
Backends\APG-Backend\Default\logs\cache-0-0.log
Collecting\Collector-Manager\Default\logs\collecting-0-0.log
Web-Servers\Tomcat\Default\logs\service.log
Tools\Task-Scheduler\Default\logs\scheduler-0-0.log
Tools\Webservice-Gateway\Default\logs\gateway-0-0.log

Troubleshooting service start-up problems on UNIX
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Logging in to the user interface
Log in to the user interface to use and edit reports, manage users, and customize the
interface to meet your needs
Procedure
1. Open a browser and type the following URL:
http://<Frontend-hostname>:58080/APG
2. Type the login credentials.
The default username is admin. The default password is changeme.
3. Click Sign In.
Note

You are automatically logged off after four hours.

Connecting to Centralized Management
Connect to the server so that you can access Centralized Management to install and
administer SolutionPacks.
Centralized Management is one of the multiple web applications available in EMC
M&R platform.
Procedure
1. Open a browser.
2. Type http://<serverIP:port>/centralized-management.
The serverIP is the fully qualified hostname or IP address of the server where
the EMC M&R platform frontend runs.
The port is the port number of the server.
Example:
http://myHost.emc.com:58080/centralized-management

3. Log in.
a. Default username is admin.
b. Default password is changeme.
c. Click Sign In.
After you finish
You are automatically logged off after four hours.
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Online Update overview
Online Update automatically downloads the latest versions of the SolutionPacks and
EMC M&R components from the EMC Update server to the Module Repository on the
Centralized Management (CM) server.
In a multi-server environment, the downloaded modules are distributed to all of the
remote servers managed by the CM server.

Configuring server settings for online updates
Procedure
1. Click Administration

.

2. Click Centralized Management.
3. Click Configuration > Online Update .
4. Ensure that you are on the Settings tab.
5. Check the Enabled checkbox.
6. Type your EMC Online Support username and password.
7. Click the

icon to test connectivity to the update server.

The

icon indicates that connectivity to the server has been established.

The

icon indicates that connectivity to the server failed.

8. Click Save.

Enabling the online update task
Enable the Online Update task to download the latest updates from the EMC Update
server automatically.
Procedure
1. Click Administration

.

2. Click Centralized Management.
3. On the Physical Overview page, click the <host_name> - Front End where
the Online Update task needs to run.
4. Click Tasks.
5. Type OnlineUpdate in the Search bar.
6. Click the OnlineUpdate scheduled task.
7. Click Enable.
Note

By default, this task is set to run once everyday at 12AM. You can customize
the task schedule by editing the configuration file.
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Running the online update task manually
At any time, you can run the Online Update task manually to access the available
updates.
Procedure
1. Click Administration

.

2. Click Centralized Management.
3. On the Physical Overview page, click the <host_name> - Front End where
the Online Update task needs to run.
4. Click Tasks.
5. Type OnlineUpdate in the Search bar.
6. Click the OnlineUpdate scheduled task.
7. Click Run Now.

Online Update Status
The Online Update Status tab indicates whether or not the last online update check
was successful, provides the date and time of the last successful check, and lists any
updates that are available for download.
Figure 1 Online Update Status

If a major update of the EMC M&R platform is detected, the Status tab includes a
Major Update Status section that describes the version that is available, provides a
link to the upgrade documentation, and includes a Start Download button.

Running the online update task manually
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Figure 2 Online Update Status with a major version update detected

Downloading a major update
You can use Online Update to download a major version of the EMC M&R platform.
You should only download a major version if you intend to immediately complete the
full upgrade process.
Procedure
1. Click Administration

.

2. Click Centralized Management.
3. Click Configuration > Online Update.
4. Click the Status tab.
5. Click Start Download. When the download is finished, the Download State will
change from "Not Downloaded" to "Complete."
6. Complete the upgrade process as described in the upgrade documentation.
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Online Update History
The Online Update History tab provides a download history with the names of the
components, the version numbers, and the date and time of the downloads.
The History tab also allows you to search the download history for a particular
component name or version number.

Disabling the online update task
You can disable the Online Update task if you prefer to manually download the updates
from the EMC Update server.
Procedure
1. Click Administration

.

2. Click Centralized Management.
3. On the Physical Overview page, click the <host_name> - Front End where
the Online Update task needs to run.
4. Click Tasks.
5. Type OnlineUpdate in the Search bar.
6. Click the OnlineUpdate scheduled task.
7. Click Disable.

Online Update History
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Licensing concepts
Learn how to manage and troubleshoot ViPR SRM ELMS licensing. Learn how to
upload license files, delete trial licenses, verify available licenses, and synchronize
licenses on multiple hosts.
Starting with ViPR SRM 3.0, ViPR SRM uses ViPR SRM the Electronic Licensing
Management System (ELMS) for licensing. ViPR SRM runs on the EMC M&R
platform, which uses a different licensing system. Various other products that also run
on EMC M&R, such as Software Assurance Suite (SAS) and ViPR, continue to use the
legacy license system, which is also referred to as EMC M&R licenses.
To manage ViPR SRM licensing, you need to understand permanent and trial licensing
and the relationship between EMC M&R features and the ViPR SRM ELMS licenses.

After installation: Licenses and SolutionPacks
A ViPR SRM installation includes the software for the core system features and all
SolutionPacks. Although the installation includes the software for all SolutionPacks,
your site might not have permanent licenses for all of them.
The ViPR SRM licensing method divides product content into the following three
categories:
1. ViPR SRM core software, which is a bundling of core features and selected
SolutionPacks.
2. ViPR SRM add-on SolutionPacks.
3. SolutionPacks that are not part of ViPR SRM.

EMC M&R feature names and ELMS licenses
EMC M&R is the underlying platform for ViPR SRM. EMC M&R identifies
functionality using strings known as EMC M&R feature names. ELMS licenses use a
different set of strings to refer to sets of features.
Feature names are formal references to SolutionPack names, collectors, and
components that work within the product. For example, XML Collector is the feature
name corresponding to the collector component that collects XML data. As another
example, the SolutionPack that collects VNX data uses the feature name SolutionPack
for EMC VNX. Services and components typically require multiple sets of features to
run properly.
An ELMS license maps to a set of EMC M&R features.

Trial licenses
Your ViPR SRM software can include all trial licenses or a combination of permanent
and trial licenses.
Licenses that you purchase are permanent. Other software comes with trial licenses.
Trial licenses let you test features in the UI and perform some initial configurations
before full purchase. Trial licenses typically last for 30 days after the installation time.
You cannot copy or regenerate a trial license in the product.
If all of your licenses are trial licenses, including the core software license that includes
the Web Portal feature, the software can lock out all users from accessing the UI
when the trial expires.
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License duration
Permanent licenses do not expire. Trial licenses have expiration dates, typically 30
days after the installation date.
When trial licenses expire, module license checks fail and the modules stop working. If
the Web Portal module fails, you cannot access the product.
Because the License Management UI operates behind the Web Portal module, you
must upload your permanent license file or extended trials before the 30-day license
for the core features expires. Otherwise, the UI locks and you cannot upload the
license file. If this happens, see Troubleshooting licensing on page 64.

License purchase
To convert a feature from a trial license into a permanently licensed feature, you need
to purchase a license.
To initiate the purchase of a license for a SolutionPack or ReportPack, visit EMC
Online Support using the following URL:
https://support.emc.com/servicecenter/createSR/

On the page that appears, submit a service request to EMC. Include the SolutionPack
or ReportPack name that you want to purchase.
When all purchasing transactions are complete, EMC sends you instructions for
downloading a regenerated license file for your site that includes the newly purchased
software license. Download the file to a local server, and then follow instructions in
Upload a new license file on page 62 to upload the new license file into ViPR SRM.
Note

Until the license is purchased and the new license file is obtained and uploaded into
ViPR SRM, the SolutionPack is inoperable, unless the 30-day trial license is still in
effect.

Licensing operations
Use the ViPR SRM Centralized Management UI to perform licensing management
operations, such as uploading, verifying, deleting, and synchronizing licenses.

Log in with admin credentials
You must have administrator credentials to perform license management operations.
Procedure
1. Access ViPR SRM by typing the following URL in a web browser:
http://frontend-hostname:58080/centralized-management

where frontend-hostname is the server where the ViPR SRM frontend
module is installed.
The ViPR SRM login page opens.
License duration
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2. Log in with a user account that has administrator credentials.
The Centralized Management UI opens to the Physical Overview page.
3. In the navigation tree in the left pane, click Licenses Management.
The Licenses Listing page opens. Notice the Upload and Synchronize
operational commands at the top of the page.

View license information
You can view license information in two ways in ViPR SRM. One method displays
licenses by host. The other one shows a centralized view of all licenses.
Procedure
1. Log in to ViPR SRM.
2. To view active licenses on a physical host, navigate to Administration >
Centralized Management > Physical Overview > host-name.
3. Click the Licenses tab.

The host's Licenses tab opens, as shown in the following figure. The page
shows the features with active licences on that host. It also indicates whether
licenses are permanent or trial, the expiration date for trials, and additional
license properties, if applicable.
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4. To view a consolidated list of licenses for all hosts, and to perform license
management operations, in the navigation tree in the left pane, click Licenses
Management.
The Licenses Listing page opens showing all licenses on all servers.
The following figure shows this page. Notice the ELMS permanent license,
showing all features included in the license and the license serial number. Also
notice the Upload and Synchronize commands at the top of the page.

View license information
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This table displays Information for ELMS licenses related to product name for
the license, SWID, and serial numbers.

Upload a new license file
To add a new license to your system, such as a newly purchased SolutionPack or
ReportPack license, you upload a new license file.
Before you begin
1. Purchase the required licenses.
2. Download the new license file to a local server, as directed by EMC during the
purchase process.
When you upload a license file, the new file affects all servers capable of using the
licenses.
Procedure
1. Log in to the Centralized Management UI in ViPR SRM using the following URL:
http://frontend-hostname:58080/centralized-management

2. In the navigation pane, select Licenses Management.
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3. Click Upload at the top of the page.
The License Upload dialog appears.
4. Click Browse and locate the new license file that you downloaded.
5. Click OK.
The system extracts the licenses and displays them in the table on the Licenses
Listing pane.
6. When the License Upload Complete dialog appears, click OK, and then click
Continue.
The new license automatically affects all servers capable of using the license.
7. Delete the trial licenses that correspond to newly licensed features, if any.
To delete a trial license, see Delete licenses on page 63.

Delete licenses
You can select and delete specific licenses or delete all licenses. A delete action
affects all servers that use the license.
After you install a permanent license, delete the trial licenses that are covered by the
permanent license.
Procedure
1. Log in to the Centralized Management UI in ViPR SRM using the following URL:
http://frontend-hostname:58080/centralized-management

2. In the navigation pane, select Licenses Management.
3. In the Licenses Listing table, select one or more license check boxes.
4. Click Delete.
The Delete command appears below the table. It is dimmed until you select at
least one license.
The system deletes the selected license from all available servers.

Synchronize licenses on multiple hosts
The Synchronize action ensures that all remote hosts have licenses based on those
available on the Centralized Management host.
Certain situations might cause licenses to become out of sync. For example, if a
remote host is unavailable when you perform an upload or a delete operation, those
operations would not be propagated to the offline server. Another example is if you
add a new server to your configuration, the new server would need licensing
information.
Procedure
1. Log in to the Centralized Management UI in ViPR SRM using the following URL:
http://frontend-hostname:58080/centralized-management

Delete licenses
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2. In the navigation pane, select Licenses Management.
3. Click Synchronize at the top of the page.
The system synchronizes the licenses on all remote hosts.

Troubleshooting licensing
You can resolve common licensing problems.

Permanent license stops working after host reconfiguration
If you change the configuration of a host, for example, by adding interfaces, removing
interfaces, or changing the operating system, your permanent license might stop
working. If your license does not work, obtain a new host ID and request a new
permanent license.
Before you begin
Ensure that you have a login with root, EMC M&R, or system administrator privileges
to perform this task. The user apg is the account that the application uses instead of
root.
Procedure
1. Log in to the operating system command line on the EMC M&R host server.
2. To obtain the new host ID, run one of the following operating system
commands:
Operating system

Command

UNIX

/opt/APG/bin/manage-licenses.sh host-id

Windows

C:\Program Files\APG\bin\manage-licenses.cmd hostid

The command output is the new EMC M&R host ID.
3. Copy the host ID information to the clipboard or to a text file.
4. To obtain the new license, go to the EMC support site using the following URL:
https://support.emc.com/servicecenter/createSR/

The Create a Service Request page opens.
5. Submit a service request to EMC, asking for a new permanent license file for a
new host. Paste the new host ID into the request.
6. When EMC sends you the new license file, follow the procedure in Upload a new
license file on page 62.

Users are locked out of ViPR SRM
If the license for the core ViPR SRM features expires, the system locks users out of
the UI.
To recover from this scenario:
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1. Obtain a license file with permanent licenses. See License purchase on page 59.
2. Install the new license file from the command line. See Install license file from the
command line on page 65.
3. Restart the Tomcat service. See Restart Tomcat service on page 65.
4. Log in to ViPR SRM and perform the following tasks:
a. Reinstall the new license file from the Centralized Management UI.
b. Delete the expired trial licenses.
See Reinstall license file and delete trial licenses after lockout on page 66.

Install license file from the command line
You can install a license file from the command line if you are locked out of the UI.
Always use the UI unless you are locked out.
Before you begin
l

Ensure that you have an OS account with root, apg, or system administrator
privileges. The application uses the apg account, rather than root.

l

Acquire a new license file from EMC and download it to a local server. To request a
new license file, create a Service Request on EMC Online Support.

Procedure
1. Log in to the server where the ViPR SRM core software is installed.
2. Copy the new, valid license file to this same server. The file is a .zip file.
3. At the OS command line, navigate to the bin directory.
4. Install the license file using one of the following commands appropriate to your
OS:
Operating
System

Command

UNIX
./manage-licenses.sh install download_path/license.zip

Windows
manage-licenses.cmd install download_path\license.zip

Note

The command installs the license file on this server only.

Restart Tomcat service
If the Web Portal license expires, you might need to restart the Tomcat service.
Before you begin
1. Install the new license file using operating system commands.
2. Ensure that the library search path is correct on the server that is the host for the
core software. This requirement applies to the libstdc package on a Solaris
server and the libaio package on a LINUX server.
Users are locked out of ViPR SRM
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It is only necessary to restart the Tomcat service when the license for a web
application, such as the Web Portal, expires.
Procedure
1. Log in to the server where the ViPR SRM core software is installed.
2. At the OS command line, navigate to the bin directory.
3. Run one of the following commands appropriate to the OS:
Operating System

Command

UNIX

./manage-modules.sh service restart tomcat

Windows

manage-modules.cmd service restart tomcat

The command output starts like this:
* Starting 'tomcat Default'... [ OK ]

Reinstall license file and delete trial licenses after lockout
After you install a permanent license file on the command line, you need to reinstall
that file using the Centralized Management UI to make the license visible in the UI and
available for distribution to other remote servers. You also need to delete the expired
trial licenses.
Procedure
1. Open a browser and log in to the Centralized Management UI in ViPR SRM
using the following URL:
http://frontend-hostname:58080/centralized-management

2. In the navigation pane, select Licenses Management.
3. Click Upload at the top of the page.
The License Upload dialog appears.
4. Click Browse and locate the new license file.
5. Click OK.
The system extracts the licenses and displays them in the table on the Licenses
Listing pane.
6. When the License Upload Complete dialog appears, click OK, and then click
Continue.
The new license automatically affects all servers capable of using the license.
7. In the License Listing table, select all expired trial licenses by clicking the
appropriate check boxes.
8. Click Delete.
The Delete command appears at the bottom of the page, below the table of
licenses.
The delete action automatically affects all available servers.
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Module does not start or has no license
If a component reports that it has no license or does not start, verify the licenses on
the physical host.
Procedure
1. Log in to the Centralized Management UI in ViPR SRM using the following URL:
http://frontend-hostname:58080/centralized-management

2. Navigate to Physical hosts > host-name > Licenses.
The page shows all licenses active on this local host.
3. Inspect the Expiration column for the termination date of each license.

ELMS license entitlements
This section describes the features associated with the core ViPR SRM license as well
as the additional licenses that you can purchase.
The ELMS SRMSUITE_GENERAL feature bundles all of the basic features and
SolutionPacks that you receive as part of any ViPR SRM purchase. This bundle
enables most of the EMC M&R functionality. The first table below lists the features
included in SRMSUITE_GENERAL.
When you purchase an add-on license, you receive additional ELMS features. The addon licenses enable sets of features that ViPR SRM verifies during runtime. The second
table below lists ELMS add-on license names and the features enabled by each one.
Table 3 Features in ELMS SRMSUITE_GENERAL

ViPR SRM
Version
EMC M&R Features Included in SRMSUITE_GENERAL Added

EMC M&R
Version
Added

ReportPack for Fibre Channel Fabrics

3.0

6.3

ReportPack for Oracle

3.0

6.3

SolutionPack for Brocade FC Switch

3.0

6.3

SolutionPack for Cisco MDS Nexus

3.0

6.3

SolutionPack for Cisco UCS

3.0

6.3

SolutionPack for EMC AppSync

3.5.1

6.4u1

SolutionPack for EMC Data Protection Advisor

3.0

6.3

SolutionPack for EMC RecoverPoint

3.0

6.3

SolutionPack for EMC ViPR

3.0

6.3

SolutionPack for EMC VPLEX

3.0

6.3

SolutionPack for EMC Watch4net Health

3.0

6.3

SolutionPack for IBM LPAR

3.0.1

6.3u1

Module does not start or has no license
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Table 3 Features in ELMS SRMSUITE_GENERAL (continued)

ViPR SRM
Version
EMC M&R Features Included in SRMSUITE_GENERAL Added

EMC M&R
Version
Added

SolutionPack for IBM SVC V7000

3.0

6.3

SolutionPack for Microsoft Hyper-V

3.0

6.3

SolutionPack for Microsoft SQL Server

3.5

6.4

SolutionPack for Oracle Database

3.0

6.3

SolutionPack for Oracle MySQL Database

3.5.1

6.4u1

SolutionPack for Physical Hosts

3.0

6.3

SolutionPack for Storage Compliance

3.0

6.3

SolutionPack for VMware vCenter

3.0

6.3

APG Self-Monitoring Collector

3.0

6.3

Alerting Engine

3.0

6.3

Backend Adapter
Properties:

3.0

6.3

DatabaseAccessor Web Service

3.0

6.3

Device Discovery

3.0

6.3

Event Adapter

3.0

6.3

Event Log Processor

3.0

6.3

Formula Editor

3.0

6.3

Formula Engine

3.0

6.3

Generic Text Collector

3.0

6.3

Geomap Integration Module

3.0

6.3

iPhone Integration Module

3.0

6.3

Mib Browser

3.0

6.3

Remote Shell Collector (SSH)

3.0

6.3

Remote Shell Collector (Windows)

3.0

6.3

Report Refiner

3.6.3

6.5u3

ReportManager Web Service

3.0

6.3

SNMP Poller

3.0

6.3

SQL Collector

3.0

6.3

SSH Telnet Collector

3.0

6.3

limit.device.value=100000
limit.device.property=device
limit.device.ratio=4000000
limit.device.tolerance=10
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Table 3 Features in ELMS SRMSUITE_GENERAL (continued)

ViPR SRM
Version
EMC M&R Features Included in SRMSUITE_GENERAL Added

EMC M&R
Version
Added

Trap Receiver

3.0

6.3

VMWare Listener

3.0

6.3

VMware Collector

3.0

6.3

WMI Collector

3.0

6.3

Web Portal

3.0

6.3

XML Collector

3.0

6.3

Table 4 Features in ELMS Add-On Licenses

Enabled EMC M&R Features

ViPR SRM
Version
Added

EMC M&R
Version
Added

SolutionPack for HP 3PAR StoreServ

3.0

6.3

SRMSUITE_CENTER SolutionPack for EMC Centera
A

3.0

6.3

SRMSUITE_DATADO SolutionPack for EMC Data Domain
M

3.0

6.3

SRMSUITE_HDS_TB

SolutionPack for Hitachi Device
Manager

3.0

6.3

SRMSUITE_HPEVA_
TB

Report Pack for HP EVA; SolutionPack
for HP EVA

3.0

6.3

SRMSUITE_HPXP_P SolutionPack for HP StorageWorks
9500_TB
P9000

3.0

6.3

SRMSUITE_IBM_DS
_TB

Report Pack for IBM DS Series;
SolutionPack for IBM DS

3.0

6.3

SRMSUITE_ISILON

SolutionPack for EMC Isilon

3.0

6.3

SRMSUITE_NTAP_T
B

ReportPack for NetApp Filers;
SolutionPack for NetApp Filer

3.0

6.3

SRMSUITE_VBLOCK SolutionPack for Converged
Infrastructure

3.0

6.3

SRMSUITE_VMAX_E ReportPack for Symmetrix;
NABLER
SolutionPack for EMC VMAX

3.0

6.3

SRMSUITE_VNX

ReportPack for CLARiiON;
SolutionPack for EMC VNX

3.0

6.3

SRMSUITE_XIV_TB

SolutionPack for IBM XIV

3.0

6.3

ELMS Feature
Name
SRMSUITE_3PAR_T
B

ELMS license entitlements
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Table 4 Features in ELMS Add-On Licenses (continued)

Enabled EMC M&R Features

ViPR SRM
Version
Added

EMC M&R
Version
Added

SolutionPack for EMC XtremIO

3.0

6.3

SRMSUITE_VMAXCE SolutionPack for EMC VMAX Cloud
Edition

3.0

6.3

SRMSUITE_ATMOS_ SolutionPack for EMC Atmos
TB

3.0.1

6.3u1

VIPRSRM_SCALEIO_ SolutionPack for EMC ScaleIO
TB

3.5.1

6.4u1

VIPRSRM_ECS_TB

3.5.1

6.4u1

ELMS Feature
Name
SRMSUITE_XTREMI
O

ECS Add-on for EMC ViPR
SolutionPack

ViPR SRM ELA License
Starting with EMC M&R 6.4u1, a ViPR SRM ELA license is available under the ELMS
feature name ViPRSRM_ELA. This license grants all of the functionality and
SolutionPacks for ViPR SRM. It is equivalent to a license for SRMSUITE_GENERAL
plus all of the available ELMS features listed in the previous table.
Note

The Backend Adapter for this license allows for 1 million devices and 4 million metrics
per device.
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CHAPTER 8
Uninstallation

This chapter includes the following topics:
l
l
l
l
l
l

Overview............................................................................................................ 72
Stopping EMC M&R platform services on a UNIX server................................... 72
Uninstalling the product from a UNIX server...................................................... 72
Stopping EMC M&R platform services on a Windows server............................. 72
Uninstalling the product from a Windows server................................................ 73
Uninstalling a SolutionPack................................................................................ 73

Uninstallation
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Overview
You can uninstall a SolutionPack and uninstall EMC M&R platform from a UNIX or
Windows server.
Stop the EMC M&R platform services before uninstalling EMC M&R platform.

Stopping EMC M&R platform services on a UNIX server
Use the manage-modules.sh service stop command to stop a specific EMC
M&R platform service or to stop all EMC M&R platform services on a UNIX server.
Before you begin
Make sure you have logged in with root or APG privileges.
Note

The list of services varies depending upon which type of installation was performed,
for example, vApp, collector, backend, frontend, and so forth.
Procedure
l

Type manage-modules.sh service stop <service_name> from the bin
directory of the installation to stop a specific EMC M&R platform service.
This example shows how to stop all EMC M&R platform services:
./manage-modules.sh service stop all

Uninstalling the product from a UNIX server
Before you begin
Make sure you have a login with root privileges.
Procedure
1. Type rm -rf /opt/APG to remove the installation directory.
2. Reboot the server.

Stopping EMC M&R platform services on a Windows server
Use this procedure to stop EMC M&R platform services from the Windows desktop.
Before you begin
Make sure you have logged in with system administrator credentials to manage
services.
Note

The list of services varies depending upon which type of installation was performed,
for example, vApp, collector, backend, frontend, and so forth.
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Procedure
1. Type manage-modules.cmd service stop <service_name> from the bin
directory of the installation to stop a specific EMC M&R platform service.
This example shows how to stop all EMC M&R platform services:
./manage-modules.cmd service stop all

Uninstalling the product from a Windows server
Before you begin
Make sure you have logged in with system administrator credentials.
Procedure
1. Use the Windows Control Panel to uninstall the product.
a. Click Start > Control Panel > Programs.
b. Click Uninstall a program.
c. Select the Watch4net Solutions APG and click Uninstall.
2. Reboot the server.

Uninstalling a SolutionPack
If you no longer want to view the reports of a certain SolutionPack, you can uninstall
that SolutionPack from the server.
Procedure
1. Log in with administrator credentials for EMC M&R platform and select
Administration.
2. Select Centralized Management in the Administration tree.
3. Select SolutionPacks in the tree.
4. Select the SolutionPack that you want to uninstall in the Installed
SolutionPacks screen.
5. In the Properties area, click Trashcan icon for each instance of the
SolutionPackBlock and click Remove.

Uninstalling the product from a Windows server

73

Uninstallation

74

EMC ViPR SRM 4.0.2 Installation and Configuration Guide

APPENDIX A
Telnet and Socket Interface Ports

This appendix includes the following topics:
l

Telnet and socket interface ports for each backend...........................................76
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Telnet and socket interface ports for each backend
The telnet and socket interface for each backend must be different on that backend
host. These ports are open in the Linux firewall setting by default.
Backend Host

Backend

socket interface

telnet interface

Primary Backend
(PBE)

DB

2000

2001

Additional Backend #1 DB1
(ABE)
DB2

2100

2101

2200

2201

DB3

2300

2301

DB4

2400

2401

DB-hostname-1

2100

2101

DB-hostname-2

2200

2201

DB-hostname-3

2300

2301

DB-hostname-4

2400

2401

DB-hostname-1

2100

2101

DB-hostname-2

2200

2201

DB-hostname-3

2300

2301

DB-hostname-4

2400

2401

DB-hostname-1

2100

2101

DB-hostname-2

2200

2201

DB-hostname-3

2300

2301

DB-hostname-4

2400

2401

DB-hostname-1

2100

2101

DB-hostname-2

2200

2201

DB-hostname-3

2300

2301

DB-hostname-4

2400

2401

DB-hostname-1

2100

2101

DB-hostname-2

2200

2201

DB-hostname-3

2300

2301

DB-hostname-4

2400

2401

Additional Backend
#2 (ABE)

Additional Backend
#3 (ABE)

Additional Backend
#4 (ABE)

Additional Backend
#5 (ABE)

Additional Backend
#6 (ABE)
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APPENDIX B
SolutionPack Reconfiguration Fields

This appendix includes the following topics:
l

SolutionPack Reconfiguration Fields.................................................................. 78

SolutionPack Reconfiguration Fields
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SolutionPack Reconfiguration Fields
You can change the settings for the SolutionPack from the SolutionPack
Reconfiguration page.
Table 5 SolutionPack Reconfiguration Fields

Field

Description

Socket Collector port

On this TCP port on the Primary Backend, the
Arbiter is accepting the remote connections
from all LBCs.

APG Backend hostname or IP address

The hostname of the server where the apg
database and its backend service are running.
In this deployment, the possible options are
backend and backend2. Do not use
"localhost" for the default apg on the primary
backend.

APG Backend data port

Each apg has a backend and each backend
has its own TCP port to receive raw data. The
port must be unique only inside the server.
Refer to Configuring the Additional Backend.
In this installation, the ports are 2000, 2100,
2200, 2300 and 2400.

78

Web-Service Gateway

Each APG server has a Web-Service
Gateway. This hostname must point to the
APG server with the backend service.

Backend Web-Service Instance

The backend instance name. In this
deployment, the possible values are:
l

Default (the default backend instance
name from primary backend)

l

apg1

l

apg2

l

apg3

l

apg4

Backend database type

MySQL by default.

Backend database hostname or IP address

The hostname where the MySQL database is
running. By default, it is same as the APG
Backend hostname.

Backend database port number

The port on which MySQL is accepting
remote TCP connections. By default, it is
53306 .

Backend Database name

The database name used in MySQL. For
example, apg, apg1, apg2.

Backend database username

The user configured in MySQL. The default is
"apg"
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Table 5 SolutionPack Reconfiguration Fields (continued)

Field

Description

Backend database password

The default password for the MySQL user is
"watch4net"

SolutionPack Reconfiguration Fields
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APPENDIX C
Unattended Installation

This appendix includes the following topics:
l
l
l

Unattended installation...................................................................................... 82
Unattended installation arguments for Linux...................................................... 82
Unattended installation arguments for Windows................................................ 82

Unattended Installation
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Unattended installation
EMC M&R 6.7 and higher supports fully unattended installations, which are
particularly useful for installing the software on remote systems via scripts. This
appendix describes the installation of the platform software, but it does not include
the installation and configuration of modules or SolutionPacks.

Unattended installation arguments for Linux
l

--silent
Runs the setup script in unattended mode. No questions are asked, and the default
settings are used.

l

--accept-eula
Accepts the EULA. By providing this switch, you are confirming that you have read
and accepted the EULA.

l

l

l

l

--install-dir=<path to installation>
Overrides the default installation location. The default is typically /opt/APG.
--user=username
Overrides the default user for installation of the servers. The default is typically
apg.
--script-directory=initd_directory
Overrides the default script directory. The default is /etc/init.d.
--runlevel-directory=rcd_directory
Overrides the default runlevels directory (containing rc[0-6].d/).
The default is /etc.

l

--install-type=installation_type
Overrides the default installation type. The available options are default, minimal,
collector, backend, and frontend. The command only considers the first letter, so
--install-type=C is equivalent to --install-type=collector. The value
of the parameter is not case sensitive.

Example 1 To override the default installation and set the installation type to collector:

[root@server ~]# ./linux_setup.sh -- --install-type=collector
Example 2 To run a fully unattended installation and install as a collector in an alternate
directory:

[root@server ~]# ./linux_setup.sh -- --accept-eula --silent -install-type=collector --install-dir=/opt/SRM

Unattended installation arguments for Windows
l

82

/S
Runs the setup script in unattended mode. No questions are asked, and the default
settings are used. This must be the first argument.
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l

l

l

ACCEPTEULA =Yes
Accepts the EULA. By providing this switch, you are confirming that you have read
and accepted the EULA. The installer will refuse to run in unattended mode if you
have not accepted the EULA.
INSTALL-TYPE=installation_type
Overrides the default installation type. The available options are: default, minimal,
collector, backend, and frontend. The command only considers the first letter, so
INSTALL-TYPE=C is equivalent to INSTALL-TYPE=collector. The value of
the parameter is not case sensitive.
/D
Sets the default installation directory. This must be the last parameter. It cannot
contain any quotes (even if the path contains spaces), and only absolute paths are
supported.

Example 3 To run a fully unattended installation and install as a collector in an alternate
directory:

C:\Users\user1> windows_setup.exe /S /D=C:\SRM /
ACCEPTEULA=Yes /INSTALL-TYPE=collector

Unattended installation arguments for Windows
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